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DONATING
USED
COMPUTER

The URL listed is for the
Computer Recycling Center. All
of the info needed (and then
some) is listed on the site.
http://www.crc.org/

SVCG UG
BENEFITS &
USER GROUP
DISCOUNTS

O’Reilly
Members receive a 20% dis-
count on O'Reilly books and
conferences. Contact Kathy for
the code.

NEW RIDERS BOOKS

http://www.newriders.com

BECOME A NEW RIDERS
CLUB MEMBER. You can save
up to 20% on all books every
day at newriders.com simply
by becoming a New Riders
Club Member. Membership is

New
Riders

http://www.vom.com/svcg/index.html

free and easy. All you have to do is
answer a few, short questions in our
ongoing, online survey, which you
can access on any book page. Don't
WOrTY.

All of your information stays with
us--we won't sell it or give it away
to anyone. After you've filled out the
profile, you'll save 20% automati-
cally whenever you log on to http://
www.newriders.com as a member.
It's that easy!

Note that you may use your User
Group Coupon Code ON TOP of
your Club Member savings. Just
remember to log in first when mak-
ing a purchase and then enter the
code at checkout as well! Contact
Kathy for code.

PEACHPIT
JOIN THE PEACHPIT CLUB

You can save 30% on all books
every day at peachpit.com simply by
becoming a Peachpit Club Member.
Membership is free and easy. All you
have to do is answer a few, short
questions in our ongoing, online sur-
vey, which you can access on any
book page. Don't worry, all of your
information is confidential and stays
with us--we won't sell it or give it
away to anyone. After you've filled
out the survey, you'll save 30% auto-
matically whenever you log on to
http://www.peachpit.com as a mem-
ber. It's that easy!

USER GROUP COUPON CODE
User group members should note
that once you've become a Peachpit
Club member, you may use your
user group coupon code ON TOP of
the permanent savings you earn as a
member of the club. Just make sure
you've logged onto the site before



you make a purchase to ensure this permanent discount]
will be in effect, then enter coupon code (case-sensi-
tive) at checkout! This coupon code is an exclusive]
offer that may not be used in conjunction with any other
coupon codes. Contact Kathy for code information.

SEPTEMBER
TOPIC

Mac Meeting:
* Your Q&A
* How to Create an iMovie

[Learn how to import images

and video, create your movie,
and burn to CD or DVD.

SVCG
@ Plugged into Technology
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AUDIOBOOK
BUILDER1.0.7

by Dan Frakes, Macworld.com

Although “Books On Tape” may be a relic of
an earlier decade, CD-based audiobooks are still
quite popular. But the popularity of the iPod (and
other portable media players) has led to a common
question from Macworld readers: How do I get
my CD audiobooks onto my i1Pod so everything
works correctly? By correctly , the reader usu-
ally means getting those tracks to show up under
Audiobooks rather than Music, keeping the book’s
chapters together, letting you navigate between
chapters, and allowing bookmarking.

You can rip your audiobook CDs in iTunes and
then spend some time massaging the resulting
audio files into formats that work like audiobooks;
in fact, we recently explained the process. But
that’s a hassle if you’re an avid book listener.
An easier—and faster—alternative is Splasm’s
Audiobook Builder 1.0.7 ( ; single user, $10;
family pack, $15). This handy utility automates
the process from beginning to end. It also lets
you create true audiobook files out of audio files
already on your hard drive; for example, tracks
you previously ripped from a CD.

http://www.vom.com/svcg/index.html



When you first launch Audiobook Builder, you create
a new Project—basically, a session for a particular
book. (The benefit of this approach is that you can
stop working on a Project at any time and come back
to it later, and you can copy a conversion-in-progress
to another Mac.) You choose the audio quality —Low,
Normal, or High Quality, or custom settings—and
then the format for the resulting audio files. For spo-
ken-word audiobooks, Low Quality is likely adequate;
if your audiobook includes music, Medium or High
Quality is preferable. The default file format is “M4B
(AAC, Bookmarkable),” which, as its name implies,
allows iTunes and the iPod (any model since and
including the iPod mini) to automatically bookmark
your audiobook so you can pick up where you last
stopped listening.

The actual process of converting an audiobook has
three steps: proving information about the book;
importing (and organizing, if necessary) the audio
files; and building the book. The first step takes place
in Audiobook Builder’s Cover screen (see the image
above): you input the book’s title and author—the
title is pre-filled with the name you gave the Project,
but you can change it if you prefer—and then drag

YOU MAKE A DIFFERENCE

New Applicant |:| Renewal |:|

Name:
Address:

Home Phone:
Work Phone:
E-mail Address:

@ Send[ ]$20 (individual) [ ] $30 (family) check to:

Sonoma Valley Computer Group
POB 649
El Verano, CA 95433

|:| I give permission to use this info in the club roster which
is for members only

Sonoma Valley Computer Group Membership Application/Renewal Form

Platform: [ ] Mac [PC [] WinXP
Operating System: [ ] OSTiger [ |Win [ | WinVIsta
[ ] OS Leopard [ ] Linux
[] 0s X [] Win98
Computer Make/Model:

How did you hear about SVCG?
[ Iclass [ _]club member [ | newspaper [ ] newsletter

User Level: [ ] Novice [] Intermediate
[ ] Advanced [] Expert
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an image of the audiobook’s cover, if you have it, to
the well in the middle of the window. (Unfortunately,
you can’t copy the image—for example, from iTunes
or Amazon.com—and paste it; you have to drop it in.)
Cover art you provide here will appear as album art in
iTunes and on your iPod.

Click the right-arrow button, or the Chapters button,
to move to the Chapters screen. This is where you tell
Audiobook Builder where to get the book’s audio. For a
CD, you simply insert the CD in your Mac’s optical drive
and then click on Import CD; an Import CD screen (see
image at right) will appear

with the CD name at the

top and the tracks listed at

the bottom. (Tip: If iTunes

is running when you insert

the CD, iTunes will auto-

matically try to locate the

CD name and track infor-

mation from the Internet;

Audiobook Builder will

grab that information from

iTunes and display it here.)

If you want each track on

the CD to be a separate

chapter, choose Import As

Individual Files.

After importing the CD,

the Chapters screen will

display the disc with its

total time. Click the triangle to the left of the disc name
to view its tracks; click the Show Details triangle to
view information about each disc or track; here you can
edit names, play any track, and even apply different art-
work for each chapter.

One aspect of the CD-import
process I found odd was that
I expected each track to be
imported as a separate chap-
ter; instead, the CD is dis-
played as a single chapter
with the CD’s tracks listed
as sections of that chapter.
To fix this, select the CD in
the list and then click on the
Split button. (It’s also possi-
ble to combine tracks/chap-
ters here, as well as to rear-
range them; however, unless
you’ve imported a book’s
CDs in the wrong order, or
have some specific reason
for editing the tracks, you
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can ignore these features.)

If an audiobook spans several CDs, place the next
disc in your Mac and click on Import CD again;
repeat the process until you’ve imported the entire
book.

The Chapters screen also lets you import audio
files already on your hard drive (for example,
audiobook chapters downloaded from a Web site
) or files you’ve previously added to iTunes. For
the former, click on Add Files and then choose the
files to import; for
the latter, select
the files in iTunes
and then click
on Add iTunes
in  Audiobook
Builder. Two
things to note here.
First,  depend-
ing on how the
files were stored
on your drive or
sorted in iTunes,
you may need to
rearrange them
in  Audiobook
Builder to ensure
they’re in the right
order.  Second,
Audiobook
Builder supports QuickTime-compatible audio
files; if you have the appropriate QuickTime
plug-ins (listed on the Splasm Web site), this even
includes unprotected WMA, Ogg, FLAC, and
Speex files. Unfortunately, Audible and protect-
ed iTunes audiobooks are unsupported (although
those files should
already be prop-
erly configured
as  audiobook

files).

Click on the
right-arrow but-
ton, or the Finish
button, to move
to the Finish
screen. You’ll
see a summary
of informa-
tion about the
resulting audio-
book file—title,
author, length,
chapters, and

http://www.vom.com/svcg/index.html



destination folder. (By default, Audiobook Builder adds
the resulting file to a new Audiobook Builder playlist in
iTunes and places the file in the iTunes Music Folder;
you can change this behavior in Audiobook Builder’s
preferences.) You can click on Cover or Chapters at
any time to return to the respective screen and made
edits. Assuming everything looks right, click on Build
Audiobook.

After the process of building the file—which was sur-
prisingly fast on my Mac Pro—is finished, the resulting
audio file appears in iTunes as a true audiobook. You can
then delete the original Project file from your Mac. Note
that Audiobook Builder audio files appear in iTunes as
“Protected” files; iTunes uses this description for all
M4B files, but Audiobook Builder files actually aren’t
protected and can be edited in any program that supports
the AAC format.

One other note: If your audiobook is over 12 hours
in length—or a smaller length, if you prefer, set via
Audiobook Builder’s preferences—it will be split into
multiple files, each under that length. This is because,
according to Splasm, 12 hours approaches the maximum
length of a track the iPod can play successfully.

Audiobook Builder is an excellent tool for getting your
audiobooks into iTunes and onto your iPod. If you’re a
regular listener of audiobooks, $10 is more than reason-
able for a utility that will save you lots of time fiddling
with file conversions, merges, and renamings. I’ve also
found it useful—as you can see in the screenshots in
this article—for converting children’s CDs to chaptered
audio files. My daughter has several such CDs with
nearly 70 short tracks each that I don’t want cluttering
up my iPod; instead, I’ve got a single track for each
CD that I can play as an audiobook when she wants to
listen, and iTunes and my iPod remember where we left
off each time.

Audiobook Builder 1.0.7 requires Mac OS X 10.4 or
later and is a Universal binary.

BEAN 1.3.3

by Dan Frakes, Macworld.com

http://www.macworld.com/article/135436/2008/09/
bean.html?Isrc=mwgems

If you need more text-editing goodness than OS X’s own
TextEdit provides, but don’t want to splurge for Apple’s
1iWork or Microsoft’s Office 2008, consider Bean 1.3.3,
an easy-to-use, fast, rich-text editor that adds a number
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of features absent from TextEdit. Bean natively sup-
ports .rtf, .rtfd, .txt, .html, and .webarchive formats.
It also uses the same OS X services as TextEdit to
open .doc, .xml, .odt, and .docx files, although, as
with TextEdit, some documents translate better than
others. (You can see more about limitations with
Word files here.)

To my eyes, Bean’s interface is cleaner and more
accessible than TextEdit’s. But it’s the additional
features that really make Bean unique. When writ-
ing, Bean gives you live-updated word and char-
acter counts, and a Get Info button provides useful
statistics about the current document, including the
number of lines, carriage returns, paragraphs, and
pages; you can also select text to see the number
of words and characters in the selection. And in
addition to standard find/replace features, Bean lets
you select text by font (style, family, size, or color),
highlight color, ruler, or combinations of these attri-
butes, making it easy to reformat matching sections
of a document. Bean also makes it simple to match
selected text to other parts of your document, and
provides a few clever editing commands, such as
Invert Selection.

Bean also offers a number of useful viewing options.
You get live zoom resizing using a simple slider; a
page-layout mode; and a full-screen editing mode.
Among my favorite features is one-click access to
an alternate-color mode for better visibility in low-
light situations; the default scheme is white text on a
dark-blue background, but you can choose your own
colors. Bean can also display invisible characters,
and a floating-window mode forces Bean’s windows
to float above other programs even when Bean isn’t
the frontmost program.

Bean’s Inspector palette provides easier access
to features such as highlighting and spacing than
TextEdit’s various palettes and windows. While test-
ing Bean, I also appreciated the auto-save feature and
an option to automatically save date-stamped back-
up versions of my documents. And Bean includes an
excellent Help system.

The developer also offers a Multilingual Edition
that’s localized for Catalan, Chinese, French,

A brilliant text editor!
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German, Japanese, Korean, Slovak, and Swedish.

Of course, Bean isn’t a full-featured word processor;
it’s missing such features as footnotes, document links,
hierarchical styles, and change tracking. And TextEdit
still beats it in a few niche areas such as font kerning.
But for most people, it’s a good middle ground between
TextEdit and something like Pages or Word.

Bean 1.3.3 requires Mac OS X 10.4 or later.

Sonoma Valley Computer Group Newsletter
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JERKY SCROLLING FIX

Q: I just retired up my G5 DP machine and bought
a 24” 3.06 Gz 2G ram iMac. On the new machine
Safari’s and Firefox’s scrolling, whether with the
mighty mouse trackball or the cursor keys is “jerky”
or “choppy.” Anyone have a clue as to why, or what
to do about it?

I am generally not wowed by the performance of this
machine. In fact I am mostly disappointed. It has the
“hot” new 8800GT vid card from Nvidia, but game
performace is average at best, and sometimes unplay-
able due to vid display anomalies.. What recourse
night I have?

A1: have you updated the various software applications
you use to Intel-native versions? For example, if you
simply brought over older versions of applications like
Microsoft Office, Photoshop / Photoshop Elements,
Firefox, Games, etc that you were using on your G5,
I would expect them to run more slowly on your new
computer than they did on your old one because they
are not Intel-native; that is, they are not written for
the Intel processor in your new computer, and so their
code must be “translated™ from the PowerPC version
they were written in as they operate.

The fix is to get the new versions. In some cases
(like web browsers) just download a newer version,
or ensure that you are using the new version of Safari
that came on your new computer. In the case of com-
mercial software (like Office, Photoshop, most Games,
etc) you must buy the new versions... Using the new
Intel-native version of software can make a HUGE
difference in speed (you would particularly notice this
with resource-hungry apps like games and graphics-
intensive software).

Also - are you trying to run a Windows OS on the new
machine, perhaps (using Parallels or similar software)?
If you leave this running all the time, it will suck up
memory and system resources, slowing down other
programs. Make sure you shut this down (not just
close its windows) when not in use.

A2:1did a similar migration and this is not my experi-
ence. What I found is that if the app you are running on
the PPC is a universal binary, then it will automatically
run in native mode on the Intel. I know this for sure
because I actually had one app that would not work
after I got the new Intel machine, and I had to actu-
ally force it to use Rosetta and then the app worked.
I reported the defect to the company and they actu-
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ally fixed it, so now it works natively on the Intel
machine.

Bottom line - a universal binary has the smarts to run
natively no matter where it is installed.

But, if you do have older apps that are not universal
binaries, you will want to update them definitely.

HOW TO
DEAUTHORIZE
ITUNES

When I go to buy music a dialogue tells me that I
already have five machines “authorized” so I need
to deauthorize one to download and play music. I
think Apple has this wrong. I know I had one for
my old G4 Sawtooth, one for my G5, and one for
this machine. I might have had to burn one when I
upgraded to 10.5 and had some problems. I forgot to
deauthorize my G35 before I boxed it up :-(. How do
I work around this?

OK. I was able to fix the iTunes auth/deauth prob-
lem by going to the account tab at the Store, where
I could deauthorize all computers and then authorize
the new one (and any others I might want to reautho-
rize, up to 5 of course). Thanks for the tip on that.

It is likely that the games I am trying to play may not
be universal binaries. The problem is most notable
on the original version of Halo for Mac, which I
doubt is Intel optimized. 1’1l have to check if there is
some kind of patch to fix it.

Go to: http://www.macworld.com/arti-

cle/49193/2006/01/deauthorall.html  to read more
about deauthroizing your computers.

IPOD TOUCH >
SVIDEO > FLAT
SCREEN TV

I got a DVI to HDMI cable, hooked my MacBook
Pro up to the LCD 32” flat screen tv, and played a
slideshow in iPhoto. I mirrored the monitors (display
preference on TV side automatically defaulted to
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Panasonic, the brand of the LCD- how cool is that?) and
it looks a LOT better than from the iPod.

I got a DVI to HDMI cable, hooked my MacBook Pro
up to the LCD 32” flat screen tv, and played a slideshow
in iPhoto. I mirrored the monitors (display preference on
TV side automatically defaulted to Panasonic, the brand
of the LCD- how cool is that?) and it looks a LOT better
than from the iPod.

Reply: As far as I know all the pro-level or higher end
Macs have natively been able to utilize screen spanning/
extended desktop for many many years (as long as their
was a genuine video output port on the unit. For towers,
there had to be either a video card with two outputs or
a second video card installed to run the second moni-
tor.) The Powerbook G4 line even made switching from
Mirrored to Extended very easy with the simple push of
the F7 key. Although you would still have to go to the
monitors preferences to designate where in the virtual
field you wanted your span to be directed (for natural
mouse travel between them)

The consumer level machines (iBook/Macbook/iMac)
were limited to mirroring only - although a hack was
able to overcome this on some iBook units. It is my
understanding that the last two generations of iMacs
have been able to use an extended desktop but I don’t
know if this is also the case with the MacBook.

ANTIVIRUS PROGRAMS

Q: My SAM program is coming up for renewal soon. Is
it desirable or necessary to have an antivirus installed for
the Mac? If so, which programs are recommended?

A1: There are still no known viruses for Mac OS X that
have been successful in the wild, so there is no need
for antivirus software (and antivirus software is a lousy
preventative measure because it can’t protect against
unknown threats). If you need antivirus software for
some other reason (maybe your Mac hosts files that are
shared with Windows machines, or it’s a company
computer that’s required to have antivirus software),
I’d recommend ClamAV simply because it’s free and it
doesn’t hook itself deep into your operating system the
way other antivirus products do (in my experience, most
commercial antivirus programs destabilize the operating
system by doing this).

A2: In fact, from my experience, and from what I've
read on the various forums and technical lists I’'m on, I’d
say installing commercial anti-virus software on a Mac
is more or less a wash in terms of the extra “security”
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you get vis-a-vis the risk of having destabilizing Bad
Things happen to your Mac.

You can find a GUI Mac OS X front end to ClamAV
(ClamXav) here:

http://www.versiontracker.com/dyn/moreinfo/
macosx/24449

I do not run anti-virus software of any sort on any of
my personal/business Macs. I run in a mixed Mac/
Windows environment in my home office (all the
Windows boxen being virtual machines). I’ve been
Macs only since 1986 and more recently with the
mixed Mac/Windows environment for at least the
last 8 years now and have never had a problem with
any sort of malware.

Once every several years, just for grins, I run a
scanner like ClamAV. I have never, ever found any
malware on any of my systems... yet.

Personally, I think the best things anyone can do
about malware are:

1. Do NOT go to any non-reputable web sites
(something like 70% of the Internet web-based
delivered malware come from porn sites -- be smart,
avoid them!)

2. On your Mac, never.... EVER enter your pass-
word unless you are 100% sure why you are being
asked for it and you know what the result of entering
the password will be (i.e. you are installing CS from
Adobe, downloading Software Updates from Apple
or some such).

3. Stay up to date with all security patches from
Apple and Microsoft.

4. Seriously avoid opening email attachments (espe-
cially on Windows boxen). I have a policy of not
opening email attachments any more. This means
I loose a lot of the “humor” and videos my friends
send to me. Oh well. If that’s the worst thing I'm
missing out on in life, I figure I’'m doing alright. ;-)

5. Never click on a link in an email unless you are
100% sure of its legitimacy (most email programs
now help you figure this out, warning you if the link
is to a site other what it purports to be).

6. Never reply to any suspicious or SPAM email.
I don’t care how good the offer looks. Skip it. No,
you will not make $1,000,000 or even $10,000 for
helping anybody out. Ever. Won’t happen. And no,
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you can’t get a “free” computer. The Second Law of
Thermodynamics (as I apply it to economics ;-) pre-
cludes anything from being free.

What have I left out?
Oh yeah, anti-virus programs!

They have their place, but are HIGHLY overhyped,
especially if all you use is a Mac.

Practice safe computing!

A3: How effective is antivi-
rus software? Well, during
the malware class at SSU, one
student started with a known
virus that was detected by
every antivirus program we
had, added a single four-byte
“push” instruction that didn’t
change the behavior of the
virus in any way...and noth-
ing could detect it!

Considering that there are

documented viruses that use

far more sophisticated methods of altering their binary
code while behaving exactly the same, some going
back about 15 years, I don’t have much faith in anti-
virus software.

A4: I have been testing various Symantec AV products
for Mac as we use them for work. The Mac versions
have been less of a rewarding experience compared
to what I run in Windows XP / Vista. The latest NAV
for Mac I tested actually was causing kernel panics on
my Mac Pro with no particular reason why. I actually
ended up disabling real time scanning, disabling the
intrusion protection, and disabling scan on mount.
Basically, it just sits there, and when I right click
something I download I can choose “Scan Now” - and
after months, I’ve never run across anything.

If you follow best practices about where you down-
load from, etc, I’'m not sure the value is there yet. If
you download lots of open source stuff or stuff from
the web, it might be good to have something to scan
what you download, but beyond that I’'m not sure it’s
worth the extra trouble at this point.
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WHERE DID THESE
RSS FEEDS COME
FROM?

Q: I decided to check “bookmarks”while in Safari
and voila! I found many, many RSS feeds already
there. Some I never would have subscribed to, some
I already have alerts on, and still many many more.
Way too many to check on every day. I’'m not sure
how most of them got there!?? I did just download
and install the new update for Safari-would that
have anything to do with the plethora of RSS’s?
I run IMAC 20” Intel, refurbished and purchased
about 1 yr ago.

A: I think some of these come with Safari and if you
never got rid of them, that’s why they are there.

CAN DOWNLOADING
PDF FILES BE DAN-
GEROUS?

Q: I have a question about the dangers of download-
ing from the web. I down load programs only from
sites where I know the company - such as Smile on
My Mac, etc.

However, I DO down load PDF files extensively
- mostly instructions. Is there any danger of execut-
able malware arriving in a PDF file?

A: Theoretically, yes, but it’s extremely unlikely.
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You would have to download a PDF file that’s corrupted
in a specific way to trigger a bug in the PDF viewer
(either Preview or Adobe Reader) and use that bug to
execute its own code. The buffer overflow* is a good
example of this, but it’s an unlikely vector these days
because the huge amount of publicity that buffer over-
flows have received over the last several years has com-
pelled most major software vendors to clean up their act
and write code that isn’t prone to such bugs (although
there was one bug in Windows XP SP1 and earlier that
could expose a PC to malicious code simply by viewing
a malicious JPEG image).

In fact, Leopard has changed its memory management
scheme so that memory is allocated in a somewhat
random manner, so that when buffer overflow errors
do exist, they almost never work (because the attacker
has no way of knowing where the data he/she wants to
attack is positioned in memory relative to the buffer).

There are a few other potential exploits. For example,
Microsoft Office became notorious for macro viruses,
because they essentially made it possible for something
as seemingly innocent as a Word document to contain
arbitrary code that ran as soon as the document was
opened, without any security restrictions (the Melissa
virus is a classic example of this). I’'m pretty sure that
Preview doesn’t offer any “features” like that, but I
don’t know about Adobe Reader.

All of the other common exploits I know about are
specific to attacking servers, so I don’t think they apply
here.

* If you don’t know how a buffer overflow works and

you’d like to find out, there’s a Wikipedia article at:
<http://en.wikipedia.org/wiki/Buffer_overflow>

PHISHING

In July, Sonic.net wrote about phishing. Here is an
excerpt:

“Over the last few weeks we have seen a considerable
increase in email scam (phishing) messages targeted
at Sonic.net customers claiming to be from Sonic.net
customer service. These messages attempt to convince
customers to send their account information including
passwords back to the email originator. Please be aware
that Sonic.net will never request your password be sent
to us via email, nor will we email you requesting that
you verify your account credentials by clicking a link.
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Email is not a secure method to send account creden-
tials, and we encourage our customers not to commit
sensitive information such as account passwords,
credit card information, SSN#, etc. via email, or any
other unencrypted protocol.

We would also like to take this opportunity to remind
you that software updates are important and you
should make sure your operating system is up to
date. On Windows you can go to Internet Explorer,
then to the Tools menu, then Windows Update. On
Macintosh systems you can go to the Apple menu to
Software Updates. Individual programs should also
be checked for updates periodically. Most programs
have a function to do this, but if not you can check
the program’s web site. You can generally find a
program’s web site by opening the Help menu and
selecting “About this program.”

WHAT IS 'PUSH"?

“Push” simply refers to a technology that automati-
cally forwards updates from one computer to another,
rather than requiring a computer to check for updates
every few minutes. MobileMe allows you to make
changes to your calendars, address book, bookmarks,
and a few other things on one Mac, iPhone, or iPod
Touch, and the changes are “pushed” via MobileMe
to all of your other devices instantly.

You don’t need MobileMe to use push technology on
an iPhone. The new iPhone software (which is also
available for the first-generation iPhone) supports
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Microsoft Exchange, which has offered push technol-
ogy for years. However, the technology has largely
been restricted to corporate environments (an Exchange
license is really expensive, even by Microsoft stan-
dards), and it only works well with Outlook (Entourage
has limited support). Furthermore, while the iPhone
now supports exchange, none of the apps on the full-size
Mac OS X do (yet). So for most people, MobileMe is
the easiest way to gain access to this sort of push tech-
nology.

TWO WAYS TO MAKE A
WEB-READY IMAGE

Always work on a duplicate of your original when mak-
ing changes.

1. With the duplicate file open, choose File > Save for
Web. There, click the Image Size tab, type 600 in the
larger dimension, and click Apply. Then click Save and
give the web duplicate file a slightly different name than
the original.

2. If the original image was taken with a high-resolution
camera, you may get a warning when yo choose Save
for Web that the image dimensions are too big for Save
for Web. If that happens, choose Image > Duplicate to
create a new window that contains a duplicate of the
original image. Here you can use Image > Image Size
to reduce the number of pixels in the duplicate of the
image, and not risk downsampling your original.

OCTOBER MEETING
Back to Basics

NOVEMBER MEETING
Holiday Gift Ideas
&

Google Video

December Potluck!
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EREEWARE SITES

1) VersionTracker If you want the extended ser-
vices they offer such as update notices then they do
charge for that. http://www.versiontracker.com

2) MacUpdate http://www.macupdate.com/
There are freeware, shareware, and commercial
ware listed on their site.
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WEBSITE FOR PAPER
AND INKS

IT SUPPLIES

Located in Rolling Meadows, Il. Free shipping over
$75.00. Great prices, fast shipping. Their url is:
http://www.itsupplies.com/cgi-bin/itsupplies.storefront/
43ef41e20b95b936273f400180140684/Catalog

IWEB PHOTO GALLERY
FIXFOR FIREFOX3

My iWeb photo
gallery and slide-
shows were broken
when viewed with
Firefox 3. 1 had
tried the fix previ-
ously and it did not
work. A new version of the script to fix it is available
now and it works! You can get it here <http://www.mac-
update.com/info.php/id/27819/fix-iweb-and-firefox-3>.
Apply the fix to your iWeb app. Open your site and
here is an important part - make a change on your pages
to force an update. Nudge an object and nudge it back.
The page icon in the iWeb page navigator will turn a red
color. Save our site and then publish the entire site. This
all forces the update to be loaded. After that your site
should be fixed.

The problem involves a javascript library called
Prototype.js. Prototype was updated recently and the
way it implements a library function caused the problem.
Mozilla foundation that publishes Firefox has concept of
how it SHOULD work in their rendering engine. Apple
had applied a trick in the previous Prototype release to
do the gallery and slide shows. The update broke this
and made Firefox’s implementation incompatible with
Apples trick. Much about politics in the standards war.
Kind of like the big elephant syndrome. The script to
fix this replaces iWeb’s Prototype library with a patched
version to make it compatible with Firefox 3.

SOME APPS FOR YOUR
|IPHONE

Shazam: Free. Works on iPhone.
Use your iPhone to find the names and titles of songs
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on the radio, CD or TV. With this App you put your
iPhone to a speaker and it will find the title and art-
ist name.

AIM: Free works on iPhone and iTouch
Chat with friends with friends on AOL, AIM, .Mac
or Mobile me.

This AIM tip from MacOSX.com:

With AIM available in the iPhone’s App Store, you
can now send and receive SMS messages without
paying for a plan or individual messages. Also, this
will be even better when the notification service
works on applications sometimes this fall.

First, download AIM onto your iPhone, then start it
up. If you want to send a text message to (617) 555-
1212, just send a new IM to +16175551212. You
should receive a confirmation message from AOL
saying your message has been sent, and the user can
reply and you’ll receive it on your phone as an IM.
Hope this hint saves some people a few bucks.

AOL Radio: Free works on iPhone and iTouch
Live radio on your iPhone. Powered by CBS radio
with over 200 stations

Bloomberg - Free
Follow all your stocks on the Stock Market.

iPint - Free
Simulates drinking beer. The iPhone turns into beer
flask. Fun.

Solitaire Top 3 -$3.99
Three solitaire games including Klondike, FreeCell,
and Spider solitaire games.

Motion XPoker -$4.99
Shake the iPhone to roll the dice

Super Monkey Ball -$9.99
A game that makes use of the accelerometer. Fun.

De Blob -$7.99- A game.

SOFTWARE UPDATES

.iPhoto 7.14

This update contains new holiday greeting card
and postcard themes for use with Apple print prod-
ucts. It also addresses general compatibility issues,
improves overall stability, and addresses a number
of other minor issues.
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.iLife Support 8.3

iLife Support provides system software components
shared by all iLife *08 applications. This update improves
overall stability and addresses a number of other minor
issues. It is recommended for all users for iLife "08.
For information on the security content of this update,
please visit this website: http://docs.info.apple.com/
article.html?artnum=61798

.iWeb Update 2.04
This update addresses general compatibility issues.

.iMovie Update 7.1.4

This update addresses general compatibility issues,
improves overall stability, and addresses a number of
other minor issues.

ADVICE FOR
INSTALLING [EOPARD

Q: My cousin wants to install Leopard on a G5 power
PC; 1.8 GHz with 512 MB DDR SDRAM (whatever
that means) and 61.17 GB remaining. Currently, it’s got
OS X version 10.3.9.

He is not very computer savvy (nor am I) and I wonder
what whether he should do it himself or hire someone.
What warnings would you give him if he were to install
it himself. He says the ads say it’s easy. True?

A: If everything goes correctly, it IS easy. And that
G5 system should be able to handle Leopard just fine
(although it wouldn’t be a bad idea to get more RAM).
But things can go wrong, so you should be prepared.
Here’s what I would do:

1. Get an external USB or FireWire hard disk that is
at least the size of the G5’s internal hard drive. If you
don’t have one, you can get them at places like Best Buy.
Attach it to the computer before you begin the installa-
tion.

2. Boot from the Leopard install DVD. After you
choose your installation language, you should be able to
launch Disk Utility from one of the menus at the top of

the screen (can’t remember which one, but it’ll be easy
to find).

3. Select the G5’s internal hard disk, and click “New
Image”. In the resulting “Save as” dialog, you want to
put the image on the external hard disk, set the format
to “compressed” (since you won’t need to make changes
to it later), and you don’t need to encrypt it. This will
probably take a long time to run.
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4. Reboot the computer into its current OS (Panther)
and verify that the disk image you created is read-
able. If you can double-click on it and see an icon
for it appear on your desktop, you can be reasonably
sure it worked.

5. Shut down the computer completely. Disconnect
the external drive, then boot from the Leopard install
DVD.

6. Follow the on-screen instructions. The only
place where you’re likely to want to deviate from
the default settings is I think you’ll want to do
an “Archive and Install”, rather than a straight
“Upgrade” (the “Upgrade” option oftentimes seems
to cause problems).

At this point, you should have a working installa-
tion of Leopard. And if anything goes wrong, you’ll
be able to write that disk image back to the internal
hard disk. I won’t detail it here because I’ve never
had to do it myself (and I don’t want to give you bad
instructions), but there’s no reason that it wouldn’t
work.

MACWEDB EDITORS

Mac web editing software options have been grow-
ing in the last few years. In this overview I'll leave
out text editors like BBEdit and TextMate and
focus only on those that insulate the end user either
fully or partially from the underlying HTML code.
Understanding how to create web pages from scratch
with HTML and CSS and sometimes JavaScript adds
the ability to customize and expand your options.
But it’s a steep price to pay if you only need to put
up a small web site.

Web site creation tools fall into two rough categories
with a fair amount of overlap. Template based edi-
tors are generally the best option for the small site
webmaster as they use pre-built designs that allow
for almost instant content creation and publishing.
WSYIWYG (what you see is what you get) editors
allow you to design and position all the page ele-
ments. Those offer more flexibility coupled with
more work and need for design skill.

Template Based Editors

Template based editors offer the casual or time-
strapped webmaster a shortcut for creating web sites.
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Templates or themes are pre-designed, sidestepping the
complex design phase freeing you to simply input your
content and click to publish or update a site.

iWeb

Since Apple publish-

es iWeb it is going to

get a lot of press. The

main selling point of

iWeb is that it lets Apple, or third party, designers pro-
vide attractive templates, freeing the end user to add
content easily. Design is done by designers and we can
create web sites with a minimum of learning and fuss.
iWeb is intended to work seamlessly with Apples iApps,
which it does. Within this narrow range of expectations,
iWeb does what it is supposed to.

iWeb created sites are attractive. Unfortunately, they
have some characteristics that make them less than
desirable for business use. The main downside to iWeb
created sites is that the file sizes of iWeb created web
pages are simply too big to download quickly on any
but the very fastest internet connections. That fact alone
makes iWeb unsuitable for anything but personal web

pages.

Other shortcomings include an inability to add raw
HTML to a web page. Insulating the average user from
coding is an admirable goal but makes it impossible to
add third party services like PayPay shopping buttons or
YouTube videos. Also, an inability to use semantic page
elements hurts search engine friendliness.

Cost: Included with new Mac purchases. Part of the
iLife Suite

Bottom Line: iWeb is easy to use and creates attractive
web sites. It is fine for personal pages that friends and
family are willing to wait for.

Sandvox

Karelia Software’s Sandvox

shares much of the ease-of-use

of iWeb and manages to address

most of its shortcomings. Like

iWeb, Sandvox offers profession-

ally designed templates on which the end user can cre-
ate full websites. Also as with iWeb we are given real
time views of what the final site will look like as we are
working.

But Sandvox goes a bit farther. Pages can be constructed
with Pageltes, building blocks of content that can be
added via drag and drop. While iWeb offers easy pub-
lishing to .Mac and a more complicated export to other
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web servers, Sandvox will publish directly to any
web server with on click. (prior setup is necessary).

Like iWeb, Sandvox makes inclusion of photos or
media files a simple drag and drop affair, as well as
offering basic blog features. Also like iWeb Sandvox
also offers pre-built design templates. Unlike iWeb,
these are not designed by Apple designers and are
not quite as polished, though there are more choices.
But since Sandvox does not allow any live page
design editing the resulting files are of very reason-
able size and download speed.

The pro version of Sandvox also allows for raw
HTML inclusion, as well as PHP and JavaScript for
enhanced functionality. Your web server does have
to offer PHP for you to take advantage of this fea-
ture. The advanced version also allows for adding
HTML tags to the head section of a web page, which
helps with search engine friendliness.

Cost: $49 Standard Version - $79 Pro Version

Bottom Line: Sandvox addresses most of iWeb’s
shortcomings, though it costs noticeably more. Some
of the included templates are acceptable for small
business use. Some are quite fun for personal sites.
Though none are quite as polished as iWeb’s tem-
plates, they are better than anything a non-designer
could create.

RapidWeaver

RapidWeaver is a somewhat different

animal from Sandvox and iWeb. At

version 3.5 it is much more mature

and feature rich. But unlike the other

two programs it does not offer a real-

time preview of you web pages as you work. Editing
is done in a word processing like window and you
need to click a preview button to see what the fin-
ished product will look like. While I don’t consider
that a drawback, some do. I believe that separating
content creation from design actually frees people
from distraction.

RapidWeaver is also a bit more complicated to learn
than the other programs, but not terribly so. Basic
functionality is easy to grasp without reading the
(very good) documentation. Some more advanced
editing features, like text wrap around images,
require a small bit of digging to uncover.

Like iWeb and Sandvox, RapidWeaver plays well
with iPhoto and iTunes, making it straightforward
to drag and drop content onto a web page. And also
like iWeb and Sandvox, blog publishing, including
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podcasting is fast and easy to accomplish. The same is
true of web photo albums.

Since the program has been around for a couple of
years, independent theme designers have had plenty of
time to create new page designs. There are easliy over
a hundred available at this time and new ones coming
out regularly. These themes are sold independently of
RapidWeaver but are very inexpensive, running from
around $5-$20. Some are very attractive. Most are
competent and suitable for a wide range of sites.

RapidWeaver is a rich program and has a number of
other features like live PHP rendering and the ability
to easily mix HTML directly into a page. It also has
a plug-in acrhitecture that lets third party developers
create add-ons like Blocks, a free-form editing tool.

Cost: $39.95

Bottom Line: RapidWeaver is a very capable web site
creation program, fully suitable for the small business
owner who wants to be able to build a professional site
without learning learning web design.

Goldfish

Another template based
web site creation program is
Goldfish, which also allows
for some actual page design
customizing.

Goldfish gets around iWeb’s

large file size by limiting

the background image edit-

ing functionality and produc-

es web pages of reasonable

download size. But the downside of this is that most
of the templates available for the program are very
basic. Depending on the design skills you bring to the
project, that is either a plus or a minus. Goldfish is not
just a template based site creation tool but a web page
layout program, albeit a very basic one.

Ease of use is excellent. As with all of these programs,
integration with Apple’s system is straightforward.
Code inclusion is also available for easy inclusion of
third party web content and services.

Cost: $34.95

Bottom Line: If page layout control appeals to you more
than pre-built professional designs, Goldfish is worth
a look. It has enough functionality for a range of sites
and allows more design flexibility than RapidWeaver
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or Sandvox, though fewer other features.

WYSIWYG Editors (what you see is what you
get)

WYSIWYG editors leave you free to build your own
site your own way and take care of the coding part
for you behind the scenes. They’re what the average
person thinks of first for web site creation. They
allow for more freedom of creative design expres-
sion than the template based programs but leave you
to take care of more of the details like internal links
and image resizing.

Seamonkey

[Seamonkey]

(http://www.

mozilla.

org/proj-

ects/seamon-

key/_ is the

direct descendent, and most current version, of the
Netscape and Mozilla suites of web applications.
Seamonkey contains a module for web site editing
and creation, called Composer. According to the
Seamonkey page:

SeaMonkey’s powerful yet simple HTML edi-
tor keeps getting better with dynamic image and
table resizing, quick insert and delete of table cells,
improved CSS support, and support for positioned
layers. For all your documents and website projects,
Composer is all you need.

It may not be all you need for a large or complex site
but Seamonkey Composer is more than adequate for
the typical business brochure or personal website. It
provides a competent WYSIWYG editor and sup-
port for direct code and CSS editing.

Where Composer shines is in updating existing
web pages. Navigate to the site in the web browser
component, Navigator, select Edit Page from the
File menu and the page opens up in full editing
mode. If you have the site login information entered
in Seamonkey, simply edit the page and click the
Publish button for instant gratification.

The editing environment has the full range of text
editing capabilities as well as easy image inclusion,
and table and link creation.

Cost: Free

Bottom Line: Seamonkey Composer is an excellent
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tool for updating web sites and an competent tool for
building sites from scratch, though its cousin NVU is
better suited to that task.

Nvu

Nvu is another offshoot

of the old Netscape

Composer component.

Nvu is a stand-alone

program with versions

for Mac, Windows and

Linux. Created by the

Linspire people. The

site claims that Nvu

is “A complete Web

Authoring System for Linux desktop users as well as
Microsoft Windows and Macintosh users to rival pro-
grams like FrontPage and Dreamweaver.”

That’s hyperbole. Nvu is a very nice WYSIWYG web
editing program, though it comes nowhere close to
Dreamweaver or Frontpage in capability or polish.
It does have an perfectly capable set of features for
the one-site webmaster. It is also easier to use than
Dreamweaver. The cost of extra features is extra com-
plexity and a steeper learning curve. From the Nvu
site:

WYSIWYG editing of pages, making web creation
as easy as typing a letter with your word processor.

Integrated file management via FTP. Simply login to
your web site and navigate through your files, editing
web pages on the fly, directly from your site.

Reliable HTML code creation that will work with all of
today’s most popular browsers.

Jump between WYSIWYG Editing Mode and HTML
using tabs.

Tabbed editing to make working on multiple pages a
snap.

Powerful support for forms, tables, and templates.
Cost: Free

Bottom Line: For the non-professional web designer or
webmaster, Nvu offers a competent editor at an unbeat-
able price. While it doesn’t require any knowledge of
HTML or web coding to operate, a little knowledge
would help you make a better site, but that’s true of
most web design programs.
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Freeway

Freeway is actually two program,

Express and Pro, but the Freeway

website presents them as one with

different versions so that’s how

I’'ll address them here. Softpress

claims that “Freeway 4.2 is a

Universal Application developed

to be the fastest, easiest, most

powerful way to design and build new websites.”
That’s close to true if, by that, they mean build
from scratch, though, Nvu claims the same thing.
Compared to the template based web site creation
programs it is quite complicated to learn.

Freeway is a designer’s tool, that completely insu-
lates the end user from code. It works very much the
same way as a page layout program like InDesign or
Xpress and should be pretty easy for people comfort-
able with those programs to transfer their skills to. If
you have good graphic design skills, Freeway will
let you exercise them fully.

An advantage that Freeway offers over most web
programs is that it has quite capable image editing
features built in, especially for graphically displayed
text. These features may save you the need to use an
external image editing program.

Freeway gives very exacting layout control through
either table based layout or absolutely positioned
divs. That may give the print designer transferring
her skills to the web a warm fuzzy feeling, but makes
for somewhat brittle page layouts. Things look great
until the end user decides to make the text larger (or
smaller), or turns off images for increased download
speed. Absolutely sized and positioned page ele-
ments are great if the visitor leaves the page the way
you designed it, but don’t look so nice if the text they
are containing is resized. Freeway Pro does offer the
ability to specify relative element sizes, which to
some extent offsets this problem.

Freeway Express gives users the layout features to
create web sites. Freeway Pro offers a more special
text effect options as well as a more flexible work-
space and CSS layout capability and output options.

Cost: Freeway Express $99 - Freeway Pro $279

Bottom Line: For years, Freeway offered the only
option between hand coding and professional level
and cost web design programs. It still occupies that
niche but has some solid competition from the tem-
plate based programs. If you are a graphic designer
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who wants to build an occasional website, or want to
really design, not just build your site, Freeway is an
excellent option.

Dreamweaver

Survey a large group of web
designers and chances are 80%
of them use Dreamweaver for
at least part of their work.
Dreamweaver is the industry
standard.

Does that mean you should go

out and get a copy if you want

to build a website? Only if

you want to become a pro web

designer. Dreamweaver is a large, capable and feature
rich program that really rewards the designer/developer
who knows the field.

Dreamweaver does offer a WYSIWYG design mode
that is excellent. It is quite possible for someone with
little or no HTML knowledge to use Dreamweaver. But
the cost and the learning time involved in getting up
to speed with Dreamweaver make every other option
described so far more appealing.

Where Dreamweaver shines is as a production tool for
large sites or for integrating dynamic content into a web-
site. It has good site management capabilities and very
good integration with two other web design standards,
Flash and Fireworks. The list of features goes on and
on.

Want to use PHP, SQL, XML, CSS, JavaScript, Cold
Fusion? Dreamweaver is the ticket. Don’t even know
what those terms mean? Dreamweaver is overkill.

Cost: $399

Bottom Line: If you are a professional web designer
chances are that you already use Dreamweaver or are a
hardcore hand coder. If you are a single site webmaster,
consider other options.

Contribute

Adobe’s Contribute is really not a website creation
tool but an maintenance one. It is excellent for updat-
ing or adding to sites created with Dreamweaver. Like
Seamonkey’s Composer, it allows you to browse to a
web page and edit it in a simple but capable editor. But
it won’t let you touch the design elements of a page, just
the content.

If you are maintaining your own site, Composer is free
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and quite capable. If you are working on a company
or organization site, Contribute offers some distinct
advantages, like version control, locked page ele-
ments and backups.

Cost: $149

Bottom Line: If you hire a designer to create your
website but want to maintain it yourself, Contribute
will allow you to do so without the steep learning
overhead of Dreamweaver.

ITUNE QUESTION

Q: I have an iTunes question. I recently changed
my iTunes music library to a new drive. I pointed
iTunes to the library on the new drive, but iTunes
doesn’t seem to have synced it. All the songs say
“the original can’t be found. Would you like to locate
it?” I can’t figure out how to get iTunes to link to the
library on the new drive. Any suggestions?

A: Advanced, consolidate library
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FILE SHARING

Q: Why is it that I can connect to my MacBook from
my iMac but I can’t connect from my MacBook to my
iMac? I have used the same connection names listed in
the File Sharing and under the Go/Connect to Server in
the Menu Bar.

Al: Do you have file sharing enabled on both Macs?
Look at the “Sharing” panel in System Preferences.

If it’s enabled and properly configured (which I'm 99%
sure it is by default), the “Connect to Server” command
shouldn’t be necessary; the Macs should be able to see
each other automatically, either through the sidebar of
a Finder window (at least on Leopard) or through the
“Network”™ view (which is also easily accessible via the
“Go” menu.

I can think of two more things to check:

1. Go back to the Sharing panel, select (but don’t
uncheck) File Sharing, and click on “Options”. There
should be three main options:

Share using AFP, share using FTP, and share using SMB.
I think what you want is AFP checked, and the other two
unchecked. (As long as SMB is not selected, you can
ignore the list of users at the bottom of the dialog box.)

2. Go to the Security panel, and select the “Firewall”
tab. Either “Allow all incoming connections” should be
selected, or “Set access for specific services and appli-
cations” should be selected and “File Sharing (AFP)”
should be in the list below.

If neither of those turn up anything, I’'m out of ideas.

In case you’re wondering about the different sharing
options: you can enable SMB if you want the Mac to be
accessible to Windows PC’s, and you can enable FTP
if you want the Mac to be accessible to legacy UNIX
systems.

Note, however, that because of how Windows shares
work, the SMB service needs to store passwords in a
different format from how Mac OS X (or any UNIX-like
system) stores them, which may be considered a (very
mild) security risk. And FTP is COMPLETELY inse-
cure because it sends passwords in clear text, with no
protection whatsoever against sniffing (i.e. it’s way too
easy for an attacker to steal an FTP user’s password).

A2: You can Browse for it in the Go menu from the

finder.. I not only see both my Macs, but my wife’s Vaio
on the network
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CAMCORDER TAPE

Mini DV tape based
digital camcorders typi-
cally transfer footage into
iMovie (or other edit-
ing apps) via a firewire
connection (also known
as IEEE 1394 or iLink.)
Turn the camcorder on,
plug the firewire cable in
and connect it to the Mac, initiate iMovie and it
should recognize the camcorder and assume the tape
navigation and playback controls. This should work
pretty well for just about any version of iMovie and
any standard definition mini-DV tape based digital
camcorder and digital 8 camcorders.

If the tape in question is on an analogue medium,
such as VHS, VHS-C, or Hi8, there are a few options
for digitizing the footage into a DV file that iMovie
can recognize and edit.

If the tape is VHS, then it must be played back via

a standard VHS machine. The signal outputs can
be routed into a digitizing (AV toDV) device such
as those made by Pyro, Canopus, Formac, Pinnacle,
etc.) Or it can be routed through a digital cam-
corder that has AV to DV capabilities, also known
as Passthrough. (Not all digital camcorders have this
feature and they are becoming increasingly difficult
to find.) In each case, iMovie should recognize the
incoming signal and will digitize the footage as it
plays back from the VCR. Another method is to
purchase one of the newer dual playback devices
that include both a traditional VHS machine AND
a DVD recorder into the same unit. Typically, you
can play back your VHS tape on one half of the
unit while recording it directly onto a recordable
DVD on the other half. I generally don’t recom-
mend this process but as a last resort due to error
prone mpeg2 encoding, potentially overly complex
demuxing issues for making the resulting mpeg? file
compatible with iMovie, and generally a relatively
poor image quality in the resulting footage when
compared to other digitizing methods. (Noisy digital
artifacts and blocky pixelation)

If the tape is a VHS-C cassette, one need only
purchase a VHS-C adaptor (available at WalMart,
Target, or most electronics big box outlets and other
‘fine’ stores.) and then follow the same procedure
outlined for VHS tapes.

If the tape is a Hi8 cassette, it must be played back
either through a compatible Hi8 camcorder and then
digitized in the same manner as the VHS method
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outlined above (on a digital camcorder with passthrough
or through a digital conversion box), or it may often be
played back through a digital 8 camcorder that is back-
wards compatible. These are digital camcorders that
use the same physical cassette as the earlier Hi8 models,
but records in a digital format. Digital 8 camcord-
ers are pretty much out of production (or nearing end
of production) and only a small percentage of models
offered backwards compatibility. Those that are back-
wards compatible will play back a Hi8 tape through the
firewire port so that iMovie will recognize it and digitize
it ‘on the fly’. These are very convenient devices to
have in such cases.

There are a few other analogue video formats, but due to
obscurity and rarity, I won’t bother outlining them here.

If the conversion job is just a once or twice thing that
doesn’t justify the purchase of new equipment to digi-
tize the footage, then a reasonable option to consider is
to have the contents converted by a friend who has the
necessary equipment, or by a third party outfit that offers
such services.

GOOGLE MAPS ADDS
WALKING DIRECTIONS

by Adam C. Engst <ace@tidbits.com>
article link: <http://db.tidbits.com/article/9713>

Though relatively late to the mapping game, Google
Maps has become one of the top sites for viewing maps,
getting driving directions, and more. Now the Google
geeks have added walking directions to Google Maps,
eliminating the logic that routes cars the correct way
down one-way streets and taking into account pedes-
trian-only pathways when possible.

Since we were just travelling in England, I asked for
walking directions from the Old Mill Hotel (built in
about 1500, where we stayed for a night in Salisbury) to
the Salisbury Cathedral. When we were there, Google
Maps had outlined a 1.4 mile walk that seemed some-
what excessive, and indeed, the nice people at the hotel
pointed us to the Town Path, a pleasant little walkway
across the water meadows that connects to the rest of

Sonoma Valley Computer Group Newsletter

the city. Alas, even Google’s new walking directions
knew nothing of the Town Path, and suggested a
much longer route along city streets. Compare the
red actual walking route to Google’s suggested route
in the screenshot.

<http://www.tidbits.com/resources/2008-07/Google-
Maps-walking-directions.png>

Similarly, when I asked Google Maps for directions
from the hotel we stayed at in Portsmouth to the
Portsmouth Historic Dockyards where we saw HMS
Victory, HMS Warrior, and the Mary Rose, Google
stuck to roads, ignoring Portsmouth’s Millennium
Promenade, which provides a far more enjoyable
stroll along the shore.

Google is aware that there are many pedestrian
walkways that they don’t know about, and they’re
working on ways of collecting new data about them
and soliciting feedback from those with their feet
on the ground about the best routes. Of course, I
hope that Google acknowledges that the “best” route
isn’t always the most efficient; walking along the
Millennium Promenade in Portsmouth very well
may not have been the fastest way to our destination,
but it was well worth an extra 5 or 10 minutes for the
ocean views, and to avoid car fumes, intersections,
and worrying about whether our 9-year-old was
paying sufficient attention to which direction the
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cars would be coming whenever we crossed a road.

<http://google-latlong.blogspot.com/2008/07/pound-
pavement.html>

@ Peachpit

MACTIP OF THE WEEK
#181

Excerpted from iPhoto 08 for Mac OS X: Visual
QuickStart Guide by Adam C. Engst

Finding Missing Photos in iPhoto

If other 1Apps can’t see your photos, or if some iPhoto
albums or photos are missing, quit all the iApps, drag
the file “AlbumData.xml” from the iPhoto Library to the
desktop, launch iPhoto, create a new album, quit iPhoto,
and try the other programs again. Your missing items
should reappear.

MACTIP OF THE WEEK
#182

Excerpted from Take Control of Upgrading to Leopard
by Joe Kissell

Keep Your Mac Apps Up to Date

If you have lots of programs installed, especially ones
without built-in update checks, try the free Dashboard
widget App Update, which scans your hard disk for

applications and then looks for updates at sites like
VersionTracker and MacUpdate.

APPLE CLAIMS
MOBILEME MAIL
EULLY RESTORED

by Glenn Fleishman <glenn@tidbits.com>
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article link: <http://db.tidbits.com/article/9715>

Apple’s mysterious David G., apparently a member
of the MobileMe product team (and possibly a rela-
tive of saxophonist Kenny G), tells us in a post last
week that the 1 percent of MobileMe users stranded
without access to archived mail since 18-Jul-08 - but
with the ability to send and receive new mail since
25-Jul-08 - should all be back in action.

<http://www.apple.com/mobileme/status/>

Mr. G. says that any remaining email problems
should be unrelated to this issue. Apple established
a chat line for remaining mail problems, but says it
should only be used for these problems. Their regu-
lar chat line, which I used last week, has a 30-minute
wait time.

<http://www.apple.com/support/mobileme/mail-
chat>

I’ve critiqued Apple about the MobileMe launch
fiasco a number of times in the last few weeks; how
would I have handled it? I’ve been in situations
with much smaller numbers of customers or clients
where outages have occurred, and worked with firms
that have gone through such outages (as a customer
or client).

1. MobileMe’s launch should have been delayed.
Steve Jobs clearly told the team it needed to be
ready for the 11-Jul-08 launch; it was not. They
probably knew this. No one said, “We need to delay
MobileMe.”

2. MobileMe’s launch should have been staged.
First, iPhone 3G owners should have had access
when signing up for new accounts. Then iPhone
3G and original iPhone owners with existing .Mac
accounts or who wanted new accounts should have
been given access. Then a slow transition for users
who weren’t interested in the sync changes could
have happened over weeks.

3. When the outage affecting 1 percent of users
was discovered, Apple should have realized that the
problem was likely to take longer than a few hours
to resolve, and acknowledged the critical nature of
email to people’s businesses and personal lives.

4. Apple should have immediately posted a page for
affected users - and distributed information through
Mac news sources - where users could enter a for-
warding address to receive email during the outage.

They should also have offered to set up clean new
accounts on either MobileMe or even a competing
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service to handle email for the duration of the outage.

5. Once the outage was over, Apple could have worked
with their customers to merge their two separate archives
of email messages, let people import old mail archives,
or what have you. It wouldn’t have been pretty, but it
would have been better than a week without access to
new email or outgoing email.

Essentially, Apple waited a week to provide fresh, iden-
tically named accounts for those without email, restor-
ing email from that missing week. Over the last week,
they merged archived messages into those new accounts.
They could have made that decision earlier and been
seen as very responsive, saving thousands of people
days of frustration.

By refusing to acknowledge the problems in public for
as long as they did, Apple has instead annoyed numer-
ous customers (to put it mildly) and come off as arrogant
and incompetent.

IPHOTO SLIDESHOW
LIMITS

By Christopher Breen (mac911 @macworld.com)

Mac 911 Tip of the Week

Reader Barbara Mehlman is underwhelmed by iPhoto’s
slideshow capabilities. She writes:
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“I have iPhoto ‘06 and find that I can create a mar-
velous slideshow, but I can’t do anything with it
-- cannot post to MobileMe, can’t drag to my iDisk,
can’t drag to my Desktop. If I want to share it, it
seems the only thing I can do is export my photos to
iMovie and create a mini-movie with my still pho-
tos, and then save it and hope my PC friends can see
it. I thought the problem was that I had iPhoto ‘06,
but no. I went to an Apple store and took a free one-
hour iPhoto ‘08 seminar and both the instructor and
the Genius couldn’t get the slideshow into a Public
folder. I also called Apple Care and they said: ‘Huh?
We’re not trained on MobileMe. Can’t help. Sorry.’
Any solutions?”

I think it will be helpful to review what iPhoto ‘08
(since it’s the current version) can and can’t do with
slideshows.

As you suggest, you can’t create a slideshow in
iPhoto and simply drag the thing to the Desktop.
Similarly, when you create a slideshow, the com-
mands under iPhoto’s Share menu do you little good.
However, getting a slideshow onto MobileMe isn’t
difficult. You have a couple of options.

The first is to create your slideshow and then choose
File -> Export. In the resulting Save As sheet you’ll
see you have three options for exporting your slide-
show as a QuickTime movie--Large (640x480),
Medium (320x240), and Small (240x180). The
resulting movie will contain all the pictures in your
slideshow as well as any music and Ken Burns
effects you’ve added to it. Once you’ve turned the
slideshow into a movie you can do pretty much any-
thing you like with it -- and that includes posting it
to MobileMe as an iWeb page.

If your main concern is getting your photos online
in a way that they can be viewed as a slideshow, you
needn’t make the slideshow in iPhoto. Instead, cre-
ate an album of the photos that you’d like do display,
click the MobileMe button at the bottom of iPhoto
(again, the latest version of iPhoto), and publish that
album as a MobileMe Gallery. When people visit that
gallery they’ll have the option to view the images as
a slideshow. No, that slideshow won’t include music
nor will it have the Ken Burns effect, but I've found
losing both these options no great sacrifice.
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EIGHT WAYS THE IMAC
CHANGED COMPUTING

by Benj Edwards, Macworld.com

The iMac made an instant impression when Apple first
unveiled it in May 1998. But it didn’t start to really
shake things up unitl it began to ship—which happened
10 years ago on August 15, 1998. Arguably the most
influential desktop computer of the last decade, the
original iMac’s specifications seem quaint by today’s
standards. For $1,299, you came home with a 233MHz
PowerPC G3 processor, 32MB of RAM, a 4GB hard
drive, a 15-inch built-in monitor, and stereo speakers —
all in an amazingly stylish case.

The Bondi blue wonder heralded the return of Steve Jobs
as a visionary leader for Apple, and it halted Apple’s mid-
1990s financial freefall. Initially marketed as an easy-to-
use gateway to the Internet, the iMac transcended that
simple role and redefined the desktop PC market—not
to mention consumer industrial design—forever.

But have you ever wondered how? Here are eight ways
the original iMac shook the world.

1. It killed beige

Before the iMac, personal
computer enclosures were
stuck in a design rut. Most
manufacturers  produced
beige or gray metal boxes,
each designed as a merely
functional piece of equip-
ment instead of an aestheti-
cally pleasing creative tool.
The iMac’s desig. shattered
the status quo with its prefer-
ence for gentle curves over
harsh corners, and for vibrant
color over dull neutrality. Apple even coined a new term,
“Bondi blue” —a blue-green hue named after Australia’s
Bondi Beach shoreline—to describe the color of its new
machine. Combined with an ice-white pinstripe pattern,
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the color scheme create a stunning enclosure thereto-
fore unseen in the PC world. It made quite an impact
on the public, but that was only the beginning.

2. It hit us in the “i”

iThis, iThat — iPod, iPhone, iChat, iLife, iSight.
Where did all those lowercase iPrefixes come from.
You can thank the iMac for starting this ubiquitous
Apple branding trend.

The “1” in “iMac” originally stood for “Internet” (or
alternately: “individual, instruct, inform, or inspire,”
according to Steve Jobs’ introductory 1998 iMac
slide show). The “i” prefix even trickled out to
non-Apple product names—mostly in the form of
iPod accessories. After the Internet became ho-hum
everyday news, Apple’s iPrefix shifted meaning to
serve puns like “iSight,” or to ambiguously imply
the empowering first-person pronoun “I,” as in
“iChat.”

3. It launched on the Internet wave

Apple’s first marketing angle with the iMac relied
heavily on the expanding popularity of the Internet
in the mid-1990s. With the “i” in “iMac” being short
for “Internet,” Apple billed the iMac as an easy
way to get connected to the global network (in just
two steps, according to one Apple advertisement).
By focusing on the iMac’s Internet aptitude, Apple
chose a unique way to differentiate its product from
other computers and to leapfrog to the top of the
consumer PC heap. It worked.

4. It introduced USB to the masses

The iMac’s sole reliance on the USB interface meant
that Mac users had to throw out all their old mice,
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keyboards, scanners, printers, and external drives. The
computer’s lack of SCSI ports particularly scared Mac
pundits, who long relied on SCSI for external storage.
But at the same time, the iMac provided the first kick
start USB needed to really get off the ground. Thanks to
the iMac, many peripheral manufacturers launched their
first-ever round of USB computer accessories—it was
no coincidence that most of them shipped in transparent
blue-green housing.

5. It killed the floppy drive

Apple  launched
the Sony 3.5-inch
disk drive with
the Macintosh in
1984 —and 14 years
later, the com-
pany killed it with
the iMac, which
included no floppy
drive whatsoever.
The press greeted
the decision to omit
removable storage with considerable skepticism. But the
absence of a floppy drive was a bold statement— Apple
was declaring, “From now on you will use the Internet
and local networks to transfer your files.” And Apple
was right, even if the company was slightly ahead of the
curve: these days, most computers lack a floppy drive,
and users barely miss it.

6. It set standards for industrial design

Imitation may be the sincerest form of flattery, but when
George Foreman Grills are following your lead, it’s time
to change things up.

The next time you see a consumer thingmabob with a
translucent plastic case—especially those available in
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multiple candy colors—you can thank (or curse)
iMac chief designer Jonathan Ive. After the release
of iMac, multi-colored translucent plastic housing
became such a common staple in the consumer prod-
ucts industry that the iMac’s 1999-2000 Technicolor
parade of models almost became a parody of itself.
Apple had to move on, dropping the bright array of
colors from the product line with the release of the
flat-panel iMac in 2002. Even then, other companies
came along for the ride: most consumer electronics
devices now ship in brushed aluminum, frosty white,
or glossy black—the colors of more recent iMac
iterations.

7. It redeemed Steve Jobs

During a power struggle in 1985, Apple executives
forced Steve Jobs to resign from the company he co-
founded. After Apple purchased NeXT in 1997, Jobs
returned to Apple and soon became “interim CEO.”
The world looked to him to turn Apple around, and
he delivered: after dumping unprofitable product
lines and streamlining the business in general, Apple
was back in the black. But no amount of fiddling
with the budget could compare symbolically with
the success of the iMac—clearly Jobs’ baby —which
served as a concrete reminder of his uncanny abil-
ity to inspire those under him to create incredible
products. The iMac’s success meant Jobs’ success,
and it inspired the Apple faithful to follow him once
more.

8. It saved Apple, too

Why is this man smiling? Because the iMac helped
revive his company.

In 1996-97, the media pronounced Apple all but
dead. The company lost $878 million in 1997, but
under the renewed guidance of Steve Jobs, it earned
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$414 million in 1998 —its first profit in three years.
Those results stemmed from both reducing operating
costs and from iMac sales. And yet the iMac meant
more than just financial returns: the symbolic impact of
Apple once again having an exciting, innovative product
marked a victory in the hearts and the minds of the pub-
lic, and it proved that Apple still had the chops to stay
in business.

Thanks to continued innovation in the iMac line and
beyond, Apple is now more profitable than ever, and
will likely continue to be so. But even with the iPhones,
iPods, and iTunes dominating today’s news, we shouldn’t
forget that Apple’s 21st century success can be traced
directly back to iMac’s launch a decade ago.

[Benj Edwards is a freelance writer and Editor-in-Chief
of Vintage Computing and Gaming, a blog devoted to
computer and video game history.]

Peachpit ‘
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To get your 35% discount, use the USER GROUP
COUPON CODE. At checkout, right before enter-
ing your credit card information, enter the user group
coupon code UE-23AA-PEUF (case-sensitive). This
coupon code is an exclusive offer that may not be used
in conjunction with any other coupon codes. Remember,
this is one of your user group benefits. Support vendors
who support user groups.

BEST BUY TO SELL
IPHONE IN UNITED
STATES

by Mark H. Anbinder <mha@
tidbits.com>

article link: <http://db.tidbits.
com/article/9735>

Multiple press reports reveal that
retail chain Best Buy will begin
selling Apple’s popular iPhone for
use with AT&T’s wireless network
on 07-Sep-08 at 970 full-size stores
and 16 Best Buy Mobile stores in
the United States. The Associated
Press, Reuters, and other news outlets say Best Buy is
adding the iPhone to its stores as part of their Best Buy
Mobile division, a joint venture between Best Buy and
the UK’s Carphone Warehouse Group.

As with Apple and AT&T retail outlets, customers will
have to activate the iPhone on the AT&T network, with
a two-year commitment, before leaving the store. We
wouldn’t expect any of the other Apple or AT&T poli-
cies about iPhone purchases to be different for phones
bought at Best Buy.

Best Buy has already been successful selling iPods,
including the iPod touch, and has opened Apple-focused
store-within-a-store “mini-shops” in 600 stores. In those
locations, the iPhone will be available in the Apple mini-
shop rather than at the cell phone counter.
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MORE PHOTO
BACKUP OPTIONS
WHILE TRAVELING

by Adam C. Engst <ace@tidbits.com>
article link: <http://db.tidbits.com/article/9732>

You’re planning a big trip, and you know you’ll
be taking lots of photos with your digital camera.
What’s the best way to protect those photos while
you're away from home and your normal backup
gear?

In “Backing up Photos While Traveling” (2008-
08-11), I shared my thoughts about how to back up
while traveling, including the following:

<http://db.tidbits.com/article/9728>

* Internet Backup: If you can be certain of finding an
Internet connection with high-speed upload capabili-
ties on a regular basis, uploading photos to a photo
sharing site like Flickr or to a server you control is a
great way to ensure that disaster cannot claim your
photos.

* 1Pod Storage: Although it’s slow and limited,
Apple’s $29 iPod Camera Connector could be a
good solution if you happen to have a supported
iPod model.

* Mac Storage: We settled on the blindingly obvious
approach of copying photos from our cameras to my
MacBook every night, leaving the photos on the 4
GB SD cards as well, so we had two copies in sepa-
rate locations at all times. This worked well on this
trip, but would have fallen down if we’d been gone
much longer (since my MacBook didn’t have much
more free disk space) or if I hadn’t wanted to take
the MacBook at all.
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Ever-alert TidBITS readers immediately sent me email
with several other solutions that they’ve employed over
the years. Depending on your situation, one of these
might be just what you need on your next trip.

**Recordable Disc** -- David Malin suggests bringing

a number of recordable CDs or DVDs along with self-
addressed envelopes. Then, whenever you have enough
photos to fill up a CD or DVD, you burn a disc, pop it
in the envelope, add postage, and mail it home. This
approach would require bringing a laptop, of course,
but it eliminates the disk space concern. Eric Watson
worked around the need for the laptop by finding a shop
down the street that would burn his photos to DVD for
a few bucks. I'd be leery of depending on there always
being such a shop down the street, though it could work
if you’re mostly staying in one place. I’d also be con-
cerned about the effort of figuring out the necessary
postage and mailbox locations, but even having the
photos on disc would meet my goal of two copies in
separate locations.

**Hard Disk-Based Photo Wallet** -- Lynette Kent
and Rick Redfern enthusiastical-
ly recommended the PhotoSafe
II and Picture Porter Elite from
Digital Foci, and Dale Gould
pointed me to what look like simi-
lar devices: the NexTo eXtreme
ND2700 Portable Storage Unit and
the Vosonic VP8860 Multimedia
Viewer Recorder.

<http://www.digitalfoci.com/photo_safe.html>
<http://www.digitalfoci.com/picture_porter_elite.html>
<http://www.mydigitaldiscount.com/
CategoryProductList.jsp?cat=Browse+By+Brand%3AN
extTo:NexTo+eXtreme+ND-2700>
<http://www.mydigitaldiscount.com/
CategoryProductList.jsp?cat=Browse+By+Brand%3AV
osonic: Vosonic+VP8860+Multimedia+Viewer+Record
er>

The PhotoSafe II and the NexTo Extreme basically let
you copy memory cards to the device’s internal hard
disk; they have only small text-based LCD screens that
provide feedback. In comparison, the more-capable
Picture Porter Elite and Vosonic Multimedia Viewer
Recorder provide color LCDs that are larger than those
in cameras for viewing your photos; they can also play
and record audio and video, play FM radio, and print
directly to printers. All these devices have rechargeable
lithium-ion batteries for use away from a computer.
They can also connect to a Mac via USB 2.0, at which
point they can act as memory card readers and as normal
external hard drives. Prices depend on the size hard disk
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you want, ranging from about $130 to $500.

I’d be hesitant to buy one of these devices for a
single trip, but I like the fact that they can be used as
battery-powered external hard drives as well, since
that would make them more generally useful beyond
travel. Lynette also said that the Picture Porter Elite
can copy files back to memory cards, which would
make it possible to create additional backups on
inexpensive memory cards and mail those home for
even more peace of mind.

AUDIO CODECS
DEMYSTIFIED

by Matt, matt@smalldog.com

While the iTunes Music Store is the largest and
most convenient place to legally get your music,
many music lovers, myself included, still prefer to
buy their music the good old fashioned way. Even
though iTunes offers some lossless music, I still like
to have the actual CDs, cases, and album art. This
means that each time I go out and buy some CDs,
they have to be imported into iTunes.

There are many options for getting your music into
iTunes. The big choices are in how the music is con-
verted from CD to a computer file that iTunes can
play. In iTunes preferences, under Advanced, you
can select from several codecs and settings. Codecs
decode the information on CDs into usable files, and
each has its merits and pitfalls.

MP3 is the totally decent standard choice, but not
the best option. It is able to create music tracks that
take up very little space on your hard drive and iPod,
but sound quality leaves something to be desired. If
you require MP3 for some reason, I’d advise that
you select a high bitrate for better sound quality--
256kbps is best. This turns down the compression
a bit, and you’ll notice less distortion and artifacts
from your music.

AAC (Apple Audio Codec) is much like MP3, but
some say the quality of AAC-encoded audio is better
than MP3 files encoded at the same bitrate. You can
select “Spoken Podcast” to encode at a lower rate if
the audio is only spoken words without instrumenta-
tion. It’ll be encoded at a lower bitrate, taking much
less space on your computer or iPod. This is the type
of encoding used on all “normal” tracks for sale on
the iTunes store.
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AIFF and WAV encoded files are true to the original
track from the CD. Codecs like this are also known
as “lossless,” because there is no degradation of sound
quality from the CD to the digital file on your computer.
These codecs produce monstrous files that make my
802.11n AirPort Express choke when streaming music
to my stereo. No customization options are available
for these codecs.

The last encoding option in iTunes is Apple Lossless.
Like AIFF and WAV, this is a lossless codec, so what’s
on the disk is turned into a music file on your computer
with no degradation of sound quality. Unlike AIFF and
WAV, though, the file sizes are more manageable and
my AirPort express doesn’t hiccup even if I have a time
machine backup going at the same time. This is my
choice for importing the music on CDs into my library.

Another lossless format is called Free Lossless Audio
Codec, or FLAC. Many live performances are archived
and traded in this format. iTunes does not support this
format well, but there is a utility called Fluke (http://code.
google.com/p/flukeformac/downloads/list) that makes it
easy to play these files in iTunes. Live performances
are generally archived at the Internet Archive (www.
archive.org) as Shorten, or SHN files. This is another
lossless format that doesn’t play natively in iTunes, but
a program called xAct will convert these files into AIFF
or WAV, which can then be converted in iTunes to the
format of your choice.

From The Archives:

BEST FORMAT / FILE
SIZE FOR IMPORTING
MUSICINTO ITUNES?
by Ed, ed@smalldog.com

I have previously written about stripping DRM off of
music purchased on the iTunes store. Many readers
wrote in asking about the best file format and file size
for importing music into iTunes. Some people were
concerned about a loss of audio quality when a song
purchased from iTunes is burned to CD, and reimported
into iTunes as an MP3 or AAC file. Other people were
curious about the sound quality of a song imported into
iTunes from a CD, versus the sound quality of a song
downloaded from iTunes.

I decided to do a test, by importing the same song into

iTunes in several different audio formats. I purchased
the song from the iTunes Store, burned it to CD, and re-
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imported into my iTunes library as different bit-rate
MP3s and AAC files. I also imported the song off a
CD as different bit-rate MP3 and AAC files. I also
experimented with Apple Lossless files. I listened
to the AAC song with the same volume settings,
though a pair of professional Sony MDR-7509HD
Studio headphones.

According to Wikipedia, “Bitrate” represents the
amount of information, or detail, that is stored per
unit of time in a recording. In very general terms,
the higher the bitrate of an audio recording, the bet-
ter it sounds. Music on a CD isn’t usually referred to
has having a bitrate, but I think the bitrate of a CD
would work out to 1410 kbps. Compare this to a 128
kbps AAC file purchased from the iTunes Store. The
reason a song purchased from iTunes sounds sounds
great - very close to the quality of a track on CD - is
because the AAC file is cleverly compressed.

The most common audio compression formats used
on the Mac are AAC and MP3. As I wrote last week,
I used to always import files as MP3 files. MP3
plays back on millions (maybe billions) of devices,
and provides reasonable-to-excellent sounding audio
tracks in fairly small files. AAC is a newer, much
more sophisticated audio compression scheme. It
does not play back on as many devices as MP3s, but
this is quickly changing. Almost all new so-called
MP3 players also play AAC files, for example. AAC
is robust, and is used by Dolby and other audio com-
panies for digital audio surround-sound.

MP3 and AAC use lossy compression - every time
you convert an MP3 to an AAC, or AAC to a smaller
AAC, etc, information will be lost. It’s like taking
frozen, concentrated orange juice, reconstituting it
with water, then concentrating and freezing it again.
There is a loss of quality. When I wrote that I convert
iTunes Store purchases to MP3, some readers were
surprised - they figured I was further reducing the
quality of my purchased music. However, I’ve not
experienced that issue, even with careful listening.
More on that below.

Apple also offers the Apple Lossless format. This
format preserves CD quality, at half the size of a
CD (about 350 MB.) It’s not practical to import all
CDs as Apple Lossless files - they would take up too
much hard drive space. I use this format selectively,
depending on what I am importing.

Rather than make you read my original long winded
article, I’ll simply share my results and ask for your
feedback and your strategies for importing music
into iTunes.

Also, I should note that because of this testing,
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my strategies for importing music into iTunes have
changed!

I purchase my absolutely favorite music on CD, and then
import it into iTunes as Apple Lossless files. I rarely
use the Apple Lossless format, though - this is only for
those much-listened to ultimate CDs. Later, I can reim-
port the Lossless files as a smaller 256 kbps AAC file
as needed.

99% of the music I purchase on CD will be imported as
256 kbps AAC files. To my ears, a 256 kbps AAC file
is virtually indistinguishable from an Apple Lossless
file - which is itself virtually indistinguishable from a
CD track. Frankly, I doubt if I could tell them all apart
in a blind test. For me, a 256 kbps AAC file is the best
total balance between sound quality and file size. If
you have extremely limited storage space, you can use
the slightly smaller 192 kbps AAC file size, which also
sounds great.

Songs purchased from iTunes are 128 kbps AAC files.
As I wrote last week, I burn these songs to CD and
reimport them to strip out the DRM. Now, I have always
done this as high bit-rate MP3 files. However, in my
testing, I consistently heard differences between the
MP3 file and the AAC file. AAC was superior. From
now on, I am going to import the music I buy from the
iTunes Store as 192 MBPS AAC files. I won’t actually
get a better sounding file by re-importing the track at a
higher bit-rate. My goal is to simply avoid compressing
the audio file any more than it already has been.

About the iTunes Store tracks: I think they sound very
good. They are do not sound quite as good as music
imported at a high bit-rate from a CD, and they don’t
sound as good as listening to the CD itself. In a tightly
controlled environment, or with superior head phones,
a subtle difference can be heard. The vast majority of
the time, differences will never be noticed. I was very
surprised how well the iTunes Store songs held up to
comparison, actually.

In short, I am not going to use MP3s anymore. My
computer is now fast enough that I can always quickly
convert AAC to MP3 if I ever need to do that. Yes, it’s a
lossy conversion - but it should work great in a pinch.

So, here is where I mutter under my breath. For years I
have imported music as MP3s, so I could play back the
tunes almost anywhere. But AAC is absolutely superior
to MP3. Some weekend I will be reimporting all my
CDs as 256 kbps AAC files. I have a lot of old junk in
my iTunes library, anyway...
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MAC TREAT #55:
OPENING FILES IS
SUCH A DRAG

By Ed, ed@smalldog.com

Did you know you can open files by dragging them
onto an application icon, including icons in your
Mac’s dock? For example, let’s say you want to
open a Word file in Text Edit. Simply drag the Word
file onto Text Edit’s icon, and blammo, it opens right

up.

I use this to quickly open Photoshop files in Preview.
That saves me from waiting for Photoshop to open.

You can modify this tip to force an application
to open a file. Simply hold down the Option and
Command keys while you drag the file onto the
application icon. This is especially useful when the

Finder doesn’t recognize a “recommended applica-
tion” to open a file you know the app can read.

MAGSAFE POWER
ADAPTER EXCHANGE
PROGRAM

By Ed, ed@smalldog.com

Some owners of MacBooks and MacBook Pros have
had a problem with fraying insulation on the mag-
netic end of their MagSafe power adapters. Apple
has announced a replacement program for eligible
adapters. Adapters are considered ineligible for the
program if they show obvious signs of abuse. Apple
writes:

“You may notice a separation of the white insulation
on the magnetic end of the MagSafe adapter. Under
continued use, the cable may discolor and the rubber
molding may become deformed

Affected Products: MacBook (13-inch Late 2006),
MacBook (13-inch), MacBook Pro (15-inch Glossy),
MacBook Pro (17-inch)

Resolution - Whether your product is in or out-
of-warranty, you can take your adapter (you don’t
need to take the computer) to an Apple-Authorized
Service Provider or Apple Retail Store for evalu-
ation, and replacement if necessary. You may be
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eligible for a replacement adapter free of charge pro-
vided there are no signs of abuse. Make a reservation at
the Genius Bar before visiting your local Apple Retail
Store. To make a reservation, go to http://www.apple.
com/retail/geniusbar”

You can also bring in the MagSafe adapter to a Small Dog
retail store, or any other authorized Apple-Authorized
service provider, which you can find here:

http://www.apple.com/buy/locator/service/

FYI, any electrical device that plugs into the wall and
has exposed wires is bad...

Read more here:

http://support.apple.com/kb/TS1977

INSTALL INTERNET
EXPLORER FOR
WINDOWS ON A MAC

WITHOUT WINDOWS)

By Ed, ed@smalldog.com

It’s hard to believe, but in late 2008 there are STILL
websites that require Internet Explorer. Microsoft dis-
continued IE for Mac in 2005, which means that Mac
and Linux users are sometimes blocked from those
websites. IE for Mac was never a good browser. It’s
woefully outdated, and lacks many essential security
features. However, if you insist on getting it, download
it here:

http://mac.oldapps.com/internet_explorer.php

However, most sites that require Internet Explorer actu-
ally need the Windows version. Fortunately, a project
called called ies4osx provides all the files required to
run IE 6 and even IE 7 on Intel Macs, without installing
Parallels, Crossover for Mac, Bootcamp, or any flavor
of Windows. I’ve tried it on my Intel iMac running the
latest version of Leopard, and it worked great (as great
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as running Internet Explorer ever is).
There are a few details about installing ies4osx:

- Intel Macs only

- Tiger users need to install X11 from their original
software desks

- You need to download and install Darwine before
installing ies4osx (link is provided below; it’s an
easy installation)

- The browser(s) will be prepared right on your
Desktop

- To delete, just drag the browsers to the trash

- There are a few known issues, detailed on the
developers page. They include the caveat “Internet
Explorer 7 might not work at all, it is really only for
testing”

- This is free and awesome!

Again, I was able to successfully install IE 6 on my
Intel iMac with no problems, in less than 5 minutes
(including downloading the files).

Read more and download the software here:

http://www.kronenberg.org/ies4osx/

Mac Computer Expo
MCE2 2008

See Pg. 31 for details!
Featured Speakers:

Bert Monroy
Ronnie Roche
Tom Negrino
Dori Smith
Lesa Snider King
Shawn King
Mary Nrobury Glaser
Derrick Story

FREE ADMISSION

September 27, 2008 at Glaser Center, 547 Mendocino
Ave., Santa Rosa, CA 10:00 a.m. - 4:00 p.m.

Win a 1 TB Time Capsule!!!
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MCE or Macintosh Computer Expo is NCMUG's 15th fund-
aising event. Held this year at the Glaser Center in downtown
Santa Rosa, thousands of Macintosh enthusiast come from all
over the North Bay to visit with Macintosh product vendors
and attend informational workshops. Since 1991 the show
has grown in attendance from around 300 to over 1,000 and is
now the largest Expo of it’s type in the North Bay second only
to Mac World in San Francisco.

Great line up of speakers this year headlined by Photoshop
guru Bert Monroy, digital photo expert Derrick Story, graph-
ics evangelist Lesa King and host of YourMacLife, Shawn King.
With over two dozen vendors showing their products, and
great raffle prizes, this year promises to be the place to be
on a Saturday in September. http://www.ncmug.org/mce.
html#speakers

Saturday, September 27th, 2008
10am - 4pm
The Glaser Center
547 Mendocino Ave.
Santa Rosa, CA
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Sonoma Valley Computer Group
POB 649
El Verano, CA 95433

Topics:
e September USER GROUP MEETING
Date: Saturday, 9/13/2008

Place: Sonoma Public Library
755 West Napa Street

Time: Mac: 9 am - 10:30 am
Windows: 10:30 am - hoon

Topic: Mac Q&A at 9 a.m.
followed by
How to Create an iMovie
Windows: TBA

SONOMA VALLEY COMPUTER GROUP
MAC USERS NEWSLETTER
4

.‘ Apple User Groug for Mac and Windows Users | b



